Installation Manual

JBL Professional Intellivox - High Power series*
Models Ivx HP-DS170 and Ivx HP-DS370

(Part Nos. 587870 & 587890)

*This manual is valid for hardware series 2. Ivx HP-DS370 with serial number 15700092 and up are hardware series 2. All Ivx HP-DS170 are hardware series 2.
REFERENCE TO EC STATEMENT OF CONFORMITY

This document confirms that products manufactured by Duran Audio bearing the CE label meet all the requirements in the EMC directive 2004/108/EC and LV directive 2006/95/EC laid down by the Member States Council for adjustment of legal requirements. Furthermore the products comply with the rules and regulations from 30 August 1995 referring to the electromagnetic compatibility of devices. Duran Audio products bearing the CE label comply with the following harmonised or national standards:

**EMC:**
- EN 55103-1:2009 +A1:2012; E1, E2, E3
- EN 55103-2:2009; E1, E2, E3

**Safety:**

**Insulation:**
- Class 1

**USER’S NOTICE AND DISCLAIMER:**

No part of this manual including the software described in it may be reproduced, transmitted, transcribed, stored in a database system or translated without the express written permission of JBL Professional.

Documentation kept by the end user for back-up purposes is excluded from the above.

All products and corporate names mentioned in this manual may be registered trademarks or copyrights of their respective companies. They are used here for indicative purposes only.

The information contained in this manual has been carefully checked for accuracy; however no guarantee is given with respect to its correctness. JBL Professional accepts no responsibility or liability for any errors or inaccuracies that may appear in this manual or the products and software described in it.

Specifications and information contained in this manual are subject to change at any time without notice.

© 2016 JBL Professional. All rights reserved.
# TABLE OF CONTENTS

Reference To EC Statement Of Conformity ........................................... 2
User’s Notice and Disclaimer ............................................................. 2

1. **Important Safety Instructions** ................................................. 4

2. **Introduction** ........................................................................... 5
   - Applicable Models And Variants .............................................. 5
   - What’s In The Packaging ......................................................... 6

3. **Installation Guide** ................................................................. 7
   - Preparing For Installation ....................................................... 7
   - Signal And Control Cables .................................................... 7
   - Connector And Wiring Details ................................................ 9
     - AC Mains ........................................................................ 10
     - Audio Inputs .................................................................... 11
     - Network Connection .......................................................... 13
     - Fault Monitoring ............................................................... 14
     - Status LED ..................................................................... 16
   - Mechanical Installation of the Loudspeaker ....................... 17
     - Acoustic Centre ................................................................. 17
     - Mounting Options ............................................................. 18
     - Mounting Procedure .......................................................... 19

4. **System Checks** ................................................................. 21
   - Connecting the PC to the Intellivox ........................................ 21
   - Settings File Upload ............................................................... 21

5. **Appendix** ................................................................. 23
   - Optional Accessories ........................................................... 23
   - Drilling Template ................................................................. 24
   - Common Analogue Grounding Issues ................................... 25
   - Software and Firmware Updates ......................................... 25
   - Network Cables .................................................................. 25
1. IMPORTANT SAFETY INSTRUCTIONS

This symbol is intended to alert you to the presence of uninsulated dangerous voltages within the product’s enclosure that may be of sufficient magnitude to constitute a risk of electric shock.

This symbol is used throughout this manual and is intended to alert you to the presence of important instructions.

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
9) Do not defeat the safety purpose of the polarised or grounding-type plug. A grounding-type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety.
10) Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.
11) Only use attachments/accessories specified by the manufacturer.
12) Use only with the cart, stand, tripod, bracket or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.
13) Unplug this apparatus during lightning storms or when unused for long periods of time.

14) Refer servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

Warning – to reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

Warning – to disconnect this apparatus from the mains power supply, turn off the power at the mains supply. Note that once the connection bay is opened, live components are exposed. Never open the connection bay without first turning off the mains supply.

Warning – this apparatus is a Class 1 device and must be connected to a mains socket that provides a safety ground connection.

Warning – the installer should ensure that the mechanical mounting method employed is capable of supporting four times the weight of the unit (i.e., with a safety factor of 4x). Always use both the brackets provided with the unit.
This manual describes the recommended installation procedure for the JBL Professional Intellivox HP (High Power) series of loudspeakers.

The JBL Intellivox is a type of loudspeaker known as an active DSP-controlled loudspeaker array, which utilises the principle of mounting multiple, individually-driven loudspeaker drive units in the vertical plane at specific spacings. In addition to the drive units, the Intellivox housing contains a mains-powered electronics module containing multiple power amplifier channels and a Digital Signal Processing (DSP) section.

The Intellivox HP series models have been specifically designed for applications where a high SPL, and/or an extended audio frequency response suitable for high quality music reproduction are required.

This manual describes the following aspects of an installation:

- Necessary cabling
- Connector wiring
- Mechanical installation

After installation, the amplifier and loudspeaker should be tested for basic functionality using the supplied JBL WinControl software; the manual also describes this procedure. (Note that full configuration and control of the loudspeaker is beyond the scope of this manual; this topic is fully documented in the WinControl Help files.)

**APPLICABLE MODELS AND VARIANTS**

This manual applies to the following JBL Intellivox models*:

- Intellivox HP-DS170
- Intellivox HP-DS370 (HW series 2)

The HP-DS170 loudspeaker unit is fitted with ten 6.5” low/mid-range drivers and two 1” hi-frequency compression drivers.

The HP-DS370 loudspeaker unit is fitted with fourteen 6.5” low/mid-range drivers and two 1” hi-frequency compression drivers.

![Fig.1 The Intellivox models covered by this manual.](image)

*Other models in the Intellivox range, including the DC/IDS 115 and DC/IDS/DSX 180, 280, 380, 430 and 500, have different installation procedures and this manual should NOT be used when installing them. Refer instead to the Intellivox Installation Guide applicable to these models.*
WHAT’S IN THE PACKAGING

In addition to the loudspeaker itself, each unit is shipped with the following items:

- Two mounting hinge brackets, pre-attached* to the loudspeaker
- Installation manual (this document)
- Datasheet specific to the model
- Package of small parts, consisting of:

<table>
<thead>
<tr>
<th>REF</th>
<th>ITEM</th>
<th>QTY</th>
<th>USE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Nylon cable ties, 200 x 3.5 mm</td>
<td>6</td>
<td>Strain relief for cables</td>
</tr>
<tr>
<td>B</td>
<td>Hex head woodscrew M8 x 45</td>
<td>8</td>
<td>Mounting bracket fixings</td>
</tr>
<tr>
<td>C</td>
<td>M8 washers</td>
<td>8</td>
<td>Mounting bracket fixings</td>
</tr>
<tr>
<td>D</td>
<td>Nylon wall plugs, 10 x 50 mm</td>
<td>8</td>
<td>Mounting bracket fixings</td>
</tr>
<tr>
<td>E</td>
<td>Eye bolt M10</td>
<td>1</td>
<td>Lifting during installation</td>
</tr>
<tr>
<td>F</td>
<td>Front grill release tool</td>
<td>1</td>
<td>Front grill removal</td>
</tr>
<tr>
<td>G</td>
<td>Nylon cable ties, 98 x 2.5 mm</td>
<td>5</td>
<td>Strain relief for connectors (Items H – L)</td>
</tr>
<tr>
<td>H</td>
<td>3-pin, 3.81 mm-pitch screw-terminal female connectors, with cover</td>
<td>3</td>
<td>Audio Line Input 1</td>
</tr>
<tr>
<td>I</td>
<td>5-pin, 3.81 mm-pitch screw-terminal female connector, with cover</td>
<td>1</td>
<td>Audio Line Input 2</td>
</tr>
<tr>
<td>J</td>
<td>2-pin, 5.08 mm-pitch screw-terminal female connector, with cover</td>
<td>1</td>
<td>Failure relay</td>
</tr>
<tr>
<td>K</td>
<td>5-pin, 3.81 mm-pitch screw-terminal female connector, with cover</td>
<td>1</td>
<td>100 V-line Input</td>
</tr>
<tr>
<td>L</td>
<td>3-pin 7.5 mm-pitch screw-terminal female connector, with cover</td>
<td>1</td>
<td>RS-485 data</td>
</tr>
<tr>
<td>M</td>
<td>Mains voltage caution label</td>
<td>1</td>
<td>AC mains input</td>
</tr>
<tr>
<td>N</td>
<td>To be attached to mains connector</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Fig.2  Items in the packaging.

*The mounting brackets are pre-fitted to the loudspeaker at the factory
3. INSTALLATION GUIDE

PREPARING FOR INSTALLATION

Before starting to install the Intellivox loudspeaker, a number of points should be considered.

- It is assumed that the installation site has been the subject of an extensive DDA investigation or optimisation prior to the actual install. (DDA = Digital Directivity Analysis, the JBL proprietary simulation and optimisation software for these products*). This procedure will have identified the optimum physical location for the Intellivox loudspeaker, to accurately achieve the desired acoustic coverage. In particular, the “acoustic centre” position will have been specified, in terms of height above the finished floor. The installer should confirm that he/she has this information.

- Unless specified otherwise by the sound system designer, the Intellivox column should be installed at a position exactly perpendicular to the listening plane (i.e., vertical if the floor is horizontal). Unlike conventional loudspeaker systems, minor mechanical misalignment may lead to degraded coverage and intelligibility. Ensure (by use of a levelling device such as a spirit level) that the surfaces to which the Intellivox is to be attached are absolutely vertical and in the same plane, and that all the individual fixing holes are themselves in the same plane.

- The Intellivox operates from mains voltages ranging from 100V to 240V AC; a suitable AC mains outlet will be required at the loudspeaker location. The outlet must be on a circuit able to supply the maximum short-term in-rush current drawn by the amplifier. Refer to the datasheet supplied for the actual figures specific to the model being installed. The third terminal of the mains outlet must be connected to a proper safety ground. Local safety regulations may require a separate mains distribution network or an uninterruptible mains power supply (UPS). The mains connection to the Intellivox should incorporate a manual circuit breaker or an accessible mains plug.

- All cables to the Intellivox should pass through glands or flexible conduit at the rear of the unit. If the particular installation circumstances permit (i.e., the height of the installation and availability of spare cable length), it will usually be easier to perform all electrical connections at ground level (see “Signal and Control Cables” for full details).

SIGNAL AND CONTROL CABLES

- In addition to the mains supply, some or all of the following cables will need to be run to the loudspeaker position from the rack location. The necessity for each of these will have been determined by the system designer; the installer should ensure that he/she has these details to hand. Depending on the specific access issues, it may be better to ensure that these cables are in place before the Intellivox is mounted in position. All wiring details can be found at “Connector and Wiring Details” on page 9.

*Authorised electro-acoustic consultants or ‘build & design’ sound contractors can apply for a DDA License free of charge. This license can be obtained through our website at www.jblpro.com.
For further information please refer to the Help files and manual with the DDA software.
- **Network connection**: all Intellivox products are configured, and may also be monitored, from a PC running WinControl software. With all installations it will be necessary to upload the correct settings for each unit to obtain the desired acoustic coverage. Once this has been done, there is no longer an operational need to have the Intellivox connected to a PC because all settings are stored locally within the unit’s memory and in the event of a power failure will be automatically reloaded when power is restored. The system designer will have determined whether a permanent network connection needs to be provided. This will be the case if the Intellivox is to be monitored remotely during normal operation. Otherwise, the network wiring can be omitted, but consideration should still be given to the unit’s location with regard to ease of both initial and future access for a PC connection. It may be appropriate to install network wiring in order to provide a network access point at a location more easily accessible than the rear of the Intellivox unit itself. This network wiring should not be left open when the PC is not connected. For suitable termination see page 13. A cable with two individually foil-screened twisted pairs should be used. Details of suitable cables can be found at “Network Cables” on page 25.

- **Audio inputs**: the Intellivox accepts line level audio (0 dBV). Two separate transformer-balanced audio inputs are provided; however, units are shipped with only Input 1 active. Input 2 can be made active via WinControl. The Intellivox additionally provides a high voltage input (referred to subsequently in this manual as the “100 V input”) which accepts audio signals directly from a 70/100 V-line distribution system. Either Line Input 1 or the 100 V input can be connected.

- **Fault monitoring**: if network monitoring is not to be used, a simple surveillance function may be realised by means of the Intellivox’s ‘failure detect’ relay. This connection requires a 2-core cable.

- **Ambient Noise Sensing**: the DSP section of the Intellivox incorporates an autogain algorithm which can adjust the gain of the system in response to changing ambient noise levels.

  **Note** - this feature uses a built-in microphone and no additional connections are required.
CONNECTOR AND WIRING DETAILS

All permanent connections to the Intellivox are made at the rear of the unit.

Fig.4 Speaker Connections.

Connector Bay

Warning - risk of electric shock. Do not remove the cover plate unless the mains supply has been disconnected.

Fig.5 Rear panel.

Warning - to maintain IP rating the factory fitted PG11 Glands must be closed or tightly sealed around installed cable.
AC MAINS

**Warning** – ensure that the mains supply is switched off at the source before starting work.

**Warning** – risk of electric shock. Do not remove the cover plate unless the mains supply has been disconnected.

The mains connection to the Intellivox should incorporate a manual circuit breaker or an accessible mains plug.

**Warning** – this apparatus is a Class 1 device and must be connected to a mains socket outlet that provides a safety ground connection.

**Warning** – the presence of mains voltage is not indicated by the side panel LED or the LED display inside the connector bay. These indicate the status of the Intellivox and cannot be used as a mains voltage indicator.

To make the AC mains connection, proceed as follows:

1. The mains connector can be accessed through the rear connection panel. Remove the rear cover plate to access the input connectors.

2. The mains cable should be routed through the right hand PG11 cable gland. To maintain the Intellivox’s IP rating, the outer cable diameter should be within the range of 5 to 10 mm.

3. Strip the ends of the cable.

4. Fit the female 3-pin, 7.5 mm-pitch screw terminal connector supplied with the unit. The connector should be wired as per the table below:

<table>
<thead>
<tr>
<th>TERM</th>
<th>USE</th>
<th>EURO</th>
<th>USA</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PE (Protective Earth)</td>
<td>Green/yellow</td>
<td>Green</td>
</tr>
<tr>
<td>2</td>
<td>N (Neutral)</td>
<td>Blue</td>
<td>White</td>
</tr>
<tr>
<td>3</td>
<td>L (Live)</td>
<td>Brown</td>
<td>Black</td>
</tr>
</tbody>
</table>

Fit the lower half of the connector cover to the connector, ensuring that the cable’s outer insulation (not the three inner wires) is firmly retained under the strain relief bar. Fit screws to the strain relief bar, then clip the upper half of the cover in place.

5. Plug the wired connector into the male **Mains** connector. Fit a cable tie to the right-hand cable tie base immediately behind the male connector to provide strain relief.

Note that the safety regulations applicable to this equipment require the use of a double insulated mains feed.

6. Fully tighten the cable gland. The unit’s IP rating will be compromised if this is not done correctly.

7. **Warning** – the caution label contained in the Intellivox standard connector set must be placed on the mains cable in close proximity to the cable entry gland, or immediately inside the connector bay if using flexible conduit.

8. After making the other connections (see next pages), refit the cover plate with its gasket. Take care not to damage the gasket, and ensure that the plate is fully seated and fixed in place with all its screws to maintain the unit’s IP rating. In addition any unused cable glands should be permanently closed.
**AUDIO INPUTS**

The Intellivox is normally fitted with two transformer-balanced line inputs and one input for connection to a 100 V-line system. Selection of Input 1 and/or Input 2 as audio source is made from the WinControl software via the network, and for most installations only Input 1 may be required. However, Input 2 may be connected to a secondary signal path (in case of a failure elsewhere in the system), or to an emergency sound source.

The 100 V input uses amplifier Input 1. Do NOT simultaneously connect a line level input to the Input 1 connector and a 70/100 V-line signal to the 100 V input connector.

For optimum results only use good quality balanced audio cable consisting of a twisted pair and an overall screen. The audio source(s) (e.g., the Octadrive) should have a low impedance balanced output. The nominal line input level is 0 dBV.

The line level analogue audio inputs use 3-pin 3.81 mm-pitch screw terminal connectors. Mating connectors are supplied with the unit. The inputs should be wired as follows:

For the Intellivox is being fed from equipment whose outputs are on 3-pin XLR connectors, follow the wiring procedure below:

<table>
<thead>
<tr>
<th>XLR PIN</th>
<th>INPUT CONN PIN</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>Screen</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Signal + (‘hot’)</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>Signal – (‘cold’)</td>
</tr>
</tbody>
</table>

If the source equipment has a well-designed balanced output and the wiring strategy shown above is used, there should be no problems with hum or other extraneous noise. Note that pin 1 of the XLR and pin 2 of the terminal connector are analogue audio grounds and should be used only for connecting the screen of the audio cables, and for no other purpose. See Fig.8.

The 100 V input uses a 2-pin 5.08 mm-pitch screw terminal connector. A mating connector is supplied with the unit. The input should be wired according to the diagram shown below:

![Fig.7 Analogue input (US wiring).](image)

![Fig.8 Balanced wiring (US).](image)

If the source equipment has a well-designed balanced output and the wiring strategy shown above is used, there should be no problems with hum or other extraneous noise. Note that pin 1 of the XLR and pin 2 of the terminal connector are analogue audio grounds and should be used only for connecting the screen of the audio cables, and for no other purpose. See Fig.8.

The 100 V input uses a 2-pin 5.08 mm-pitch screw terminal connector. A mating connector is supplied with the unit. The input should be wired according to the diagram shown below:

![Fig.9 100 V-line wiring.](image)
Due to the complex architecture of some large audio systems, unexpected hum or noise may occur due to ground loops, or injected noise from other equipment elsewhere in the system. If this occurs, please refer to the appendix of this manual ("Common Analogue Grounding Issues" on page 25), where additional guidance on grounding strategies will be found, with general techniques that may be applied in order to reduce ground-induced noise.

To minimize hum and noise pickup, balanced analogue interconnections between audio sources and the Intellivox should always be used wherever possible. If driving from an unbalanced source, use the same wiring as shown above at the Intellivox end, but connect the ‘hot’ core to the signal output and the ‘cold’ core to the ground terminal of that output; the cable’s own screen should be connected at the Intellivox end only.
NETWORK CONNECTION

The RS-485 network connection should be wired if the Intellivox is to be constantly monitored in operation.

The RS-485 interface permits multiple units to be “daisy-chained” in parallel, so that all units are controlled by the same PC. In such a system, each Intellivox must have its own unique network address; this is determined via WinControl for each individual Intellivox.

The network connection uses a 5-pin, 3.81 mm-pitch screw-terminal connector, and should be wired as shown in the table and diagram below:

<table>
<thead>
<tr>
<th>PIN NO.</th>
<th>USE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DGND</td>
</tr>
<tr>
<td>2</td>
<td>Y (Data Tx +)</td>
</tr>
<tr>
<td>3</td>
<td>Z (Data Tx -)</td>
</tr>
<tr>
<td>4</td>
<td>B (Data Rx -)</td>
</tr>
<tr>
<td>5</td>
<td>A (Data Rx +)</td>
</tr>
</tbody>
</table>

Note that two-pair, individually-screened cable should be used for RS-485 communications. The transmit (Tx) and receive (Rx) balanced data lines must be wired via their own twisted pairs. Cat 5 (or better) type UTP or FTP cable is NOT suitable. Please refer to the Appendix section (on page 25) at the end of the manual for cable specifications.

The maximum cable length over which the network connection will operate reliably depends on the cable type and the baud rate used. With good quality cable, a safe maximum figure (at 19.2 kbaud) is 2000 m. If the distance is significantly greater than this, a network repeater will be required.

Further information on the RS-485 network can be found in the manual for the USB to RS-485 converter and in the WinControl Help files.

Before connecting multiple devices to the same network subnet, ensure that their network addresses do not overlap. Each device should be set to a unique network address (determined via WinControl).

In some installations, it is normal practice to disconnect the RS-485 network at the XLR5 connector on the USB to RS-485 converter at the host (computer) during normal operation. This removes the possibility of extraneous data being inadvertently transmitted over the network. In such a situation, the converter is only reconnected when system maintenance or checks are required. Disconnecting from the converter in this way leaves the Rx lines of the devices unterminated. In most situations this does not present any problems, but with a large network in a hostile EMC environment, it is recommended that the host Y and Z lines (host device Tx/Intellivox Rx) are terminated in a 100 Ohm resistor for normal operation. This can be easily achieved by plugging the XLR5 female connector into a spare male connector with the resistor on the appropriate pins. This termination can then be removed and the converter reconnected when necessary. (If there is any doubt about which pins should be terminated, shorting all five pins will generally be equally effective.)
FAULT MONITORING

The Intellivox includes a failure relay whose contacts are accessible on a 3-pole 3.81 mm-pitch screw terminal connector, and should be wired as shown in the table and diagrams below (Fig.12). The conditions under which the relay operates are defined as part of the Intellivox configuration in WinControl.

<table>
<thead>
<tr>
<th>PIN NO.</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Common</td>
</tr>
<tr>
<td>2</td>
<td>10k/20k Ohm</td>
</tr>
<tr>
<td>3</td>
<td>Short/open</td>
</tr>
</tbody>
</table>

The relay connections are available either as volt-free, or with additional internal resistors to allow them to be connected directly to impedance-sensing line monitoring equipment such as the AXYS Cerberus. This selection is made by wiring the appropriate pins as shown in Fig.12.

- **Volt-free mode**: In volt-free operation, ‘Common’ is connected to ‘Short/open’; a failure condition causes ‘Common’ to disconnect from ‘Short/open’. 

![Volt-free configuration.](image)

![Impedance-sensing configuration.](image)

Fig.12 Failure Relay Connector.
• **Impedance sensing mode:** When wired for impedance-sensing use, the impedance between 'Common' and pin 2 is 10 kOhm. When a fault condition occurs, the impedance between 'Common' and pin 2 rises to 20 kOhm.

The relay contacts have maximum current and voltage ratings of 100 mA and 24 V respectively.

**Fault Monitoring when using the 70 V/100 V input.**

If the Intellivox’s 100 V input is in use, a simple failure monitoring scheme requiring no additional connections can be easily implemented. This is based on impedance switching.

The amplifier driving this input should be capable of detecting changes in its load impedance.

The impedance between pins 1 and 2 of the 100 V input connector can be two values:

- High impedance (> 500 kOhm @ DC).
- Low impedance (approximately 2.2 kOhm @ DC).

The Intellivox can be configured to switch to the low impedance state in case of a failure by means of the WinControl software.
**STATUS LED**

The Intellivox is equipped with an LED that can be configured to indicate the status of the failure relay. The LED is green in normal operation, and goes red when a fault condition arises. Furthermore, the LED can be activated over the network in order to identify the unit.

The single-digit seven-segment LED display on the side wall of the connector bay provides status information about the electronics section and various abnormal operating conditions that may arise. Under normal operating conditions, the display will show 0.

The codes are as follows:

<table>
<thead>
<tr>
<th>DISPLAY</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Normal operation, all OK</td>
</tr>
<tr>
<td>1</td>
<td>DSP not running</td>
</tr>
<tr>
<td>2</td>
<td>Amplifier fault</td>
</tr>
<tr>
<td>3</td>
<td>Load monitoring fault</td>
</tr>
<tr>
<td>4</td>
<td>Pilot Tone not detected at Input 1</td>
</tr>
<tr>
<td>5</td>
<td>Pilot Tone not detected at Input 2</td>
</tr>
<tr>
<td>6</td>
<td>Over Temperature</td>
</tr>
<tr>
<td>7</td>
<td>Ambient Noise Sensing microphone failure</td>
</tr>
<tr>
<td>8</td>
<td>Internal module fault</td>
</tr>
<tr>
<td>9</td>
<td>Updating firmware flash memory</td>
</tr>
</tbody>
</table>

There are 2 additional indications:

* The dot on the display is lighted as soon as it is detected that the power supply is present.
* A rotating progress indication is shown during initialization.

![Fig.13 LED display on the side wall.](image-url)
MECHANICAL INSTALLATION
OF THE LOUDSPEAKER

ACOUSTIC CENTRE

Mounting an Intellivox loudspeaker is a straightforward procedure, but it is essential to understand that the height of the unit above floor level is extremely critical. The “correct operational height” is defined as part of the acoustical design process and the installer should make sure that he/she has this information before commencing to mount the Intellivox.

The correct operational height defined by the system designer is the height of the Intellivox’s acoustic centre. This point coincides with the centre of the loudspeaker’s lowest drive unit. The location of the speaker’s acoustic centre is marked by the centre of the yellow sticker on the front face of the unit at the time of shipping, and it is this position that must correspond to the operational height defined in the design process. Note that the horizontal position of the acoustic centre is on the vertical centre line of the column.

Because of the extreme tight vertical radiation pattern of the Intellivox, a small deviation from the calculated mounting height may cause severe degradation of the expected performance. Similarly, the Intellivox should be perfectly vertical in both planes unless otherwise specified (see Fig.15 below).

When calculating the positions for the mountings (see following page), the distance from the acoustic centre to the top or bottom of the loudspeaker (whichever is being used as the reference datum) should be measured and then allowed for when marking the mounting positions. The model-specific specification sheet supplied with each loudspeaker includes a mechanical drawing clearly showing the mounting position locations.

Fig.14 Sticker showing acoustic centre and unit orientation.

Fig.15 Illustration showing the critical vertical alignment in both planes.
MOUNTING OPTIONS

The Intellivox has two attachment points at the rear of the enclosure; the device should be mounted using these points. Each point consists of four M8 threaded inserts 20 mm deep, and only the hex-headed screws supplied with the original mounting hardware should be used.

The Intellivox is equipped with a lifting assistance attachment point (M10 threaded insert) at the top of its enclosure. This should only be used for lifting during installation and should NOT be used as a permanent fixing point.

There are two options for mounting the Intellivox column:

1. The first (and most often used) method is to use the standard mounting brackets supplied ready-fitted to the unit. Dimensions of the bracket are shown in the drawing below.

The standard hinge brackets allow mounting of the Intellivox on a straight wall with a gap of 95 mm (3.75") between the rear of the enclosure and the wall. The hinge brackets allow the Intellivox to be rotated through 90 degrees, the direction of rotation being determined by their configuration.

Details of mounting procedure are provided in “Mounting Procedure” on page 19.

Note - see drilling template in Appendix.

![Mounting hinge bracket dimensions](image-url)
2. The second method is to mount the column within a recess in the wall or dedicated mounting panel so that the front of the unit is flush. This is a specialised mounting situation which will be encountered only rarely. Access to the rear of the unit will still be required for the cables. Depending on the particular circumstances, it may be appropriate to remove the mounting brackets from the rear of the unit.

Because of the proximity of the unit to the walls, particular attention should be paid to the avoidance of acoustic resonances (see below).

Cavity walls can sometimes be problematical when high-power loudspeakers are mounted on them. The internal wall cavity may resonate at one or more frequencies, degrading the audio performance significantly. Installers are advised to insert rockwool or similar sound-absorbing material into the cavity in the vicinity of the loudspeaker when mounting an Intellivox on a wall of this type.

Ensure there is sufficient airflow around the rear mounted heatsink once installed.

**MOUNTING PROCEDURE**

The general mounting procedure using the standard hinge brackets is described below. Once mounted, the hinge brackets allow access to the connector bay on the rear of the unit. A M10 lifting point is provided on the top of the unit for use during installation/maintenance.

This point should NOT be used for permanent installation. It is only intended as a lifting point to be used during installation/maintenance.

The threaded bush on the M10 lifting point has an internal length of 20 mm. Use M10 eye bolt supplied with the device. Care should be taken not to insert a longer thread into this lifting point as it could compromise the integrity of the lifting point and/or loudspeaker enclosure.
Proceed as follows:

1. Using the drilling template in the Appendix of this manual, mark the wall for the wall plugs. Refer also to the Mechanical Details drawing in the datasheet supplied with the loudspeaker. Check the dimensions given from the reference datum to each pair of mounting holes, and allow for the offset of the acoustic centre from the reference to ensure that the acoustic centre will be at the height defined in the acoustic design specification. Reference to Fig.16 may also be helpful. Drill the holes (Ø 10 mm).

2. Insert the plugs and screws into the holes. Tighten the screws with a spanner, but stop with a few mm of screw shaft visible between the head and the wall.

3. By removing the mounting plate of one bracket, check to ensure that the mounting screws are sufficiently spaced from the wall.

4. Check that the chosen mounting points will position the column in the correct vertical angle specified by the acoustic design (which is usually exactly perpendicular to the listening area). Use spacers on one or more of the brackets if necessary.

5. Lift the Intellivox and slide the brackets over the heads of the hex-head screws protruding from the wall.

6. Firmly fasten the screws securing the brackets to the wall. Re-check the verticality (or other angle if specified) with a spirit level or similar levelling device.

7. Remove hinge bolts from one side of brackets to allow rotation and access to the rear of the unit. Install all connections as described in 'Connector and Wiring Details’. Reinstall hinge bolts to secure unit in place.

The unit should not be powered during installation. The connector bay contains live parts and should only be opened if the mains power has been disconnected.
4. SYSTEM CHECKS

After installation and connection are complete, the installer should upload the settings file into the Intellivox with WinControl software. The upload procedure will verify the system’s correct operation.

This section of the manual describes the file upload procedure. It assumes that a laptop (or other computer) with both WinControl software and a driver for the RS-485 interface already installed is available, together with the JBL (or other suitable) RS-485 interface. It also assumes that the installer has the settings files, prepared by the system designer, for each Intellivox loudspeaker making up the system. These may be elsewhere on the laptop’s hard drive, or may be supplied separately on removable media such as a memory stick or a CD-ROM. No previous knowledge of WinControl is necessary, but basic familiarity with Windows file handling is required.

A full description of WinControl is beyond the scope of this manual and further information is available in the application’s Help files. Instructions on how to install WinControl on a PC are included with the Program Set. Instructions on the use of the JBL RS-485 interface are included with the interface itself.

CONNECTING THE PC TO THE INTELLIVOX

The PC connects to the Intellivox via an RS-485 interface adapter.

A cable to connect the RS-485 interface adapter to the Intellivox’s RS-485 port will need to be assembled. Note that this is not supplied with the unit.

The RS-485 interface should then be connected to a USB port on the PC.

SETTINGS FILE UPLOAD

- Apply mains power to the Intellivox, turn on the PC and launch WinControl. Open Options > Communications options, confirm that the Off-line box is unchecked and that the correct COM port is selected. Close the Communication options dialogue box. If the PC is connected to only one Intellivox, a screen similar to that shown below should now be displayed:

![Fig.18 WinControl.](image)

The green rectangle in the main pane represents the Intellivox. The model number is shown below and the unit’s current network address to the right. If a complete network comprising multiple Intellivoxes is being accessed, further similar rectangles will be displayed.

- If the display does not look like that shown, click on Command > Netscan to force the PC to re-scan the network. This will be the case if the Intellivox(es) were unpowered when WinControl was launched. If this fails to produce the correct display, please check all network connections, and that the correct port on the PC is selected (open Options > Communications options to do this).
• Select the Intellivox to have its settings file uploaded by clicking on it once, highlighting its model number and address, if it is not already highlighted. Click **File > Load settings...** which will open two dialogue boxes: **Load control parameters settings** (see below) and **Control parameters**.

![Load control parameters settings dialogue box](image)

**Fig. 19 Load control parameters settings dialogue box.**

• The **File Name** field (at the top of the **Load control parameters settings** dialogue box) indicates the last-used settings file name. If this is the first time that the installation of WinControl has been used, a default settings file is selected. The default location for this file is in `My Documents\Duran Audio BV\WinControl\Settings`, though as this is alterable, it is possible that a different location may be displayed, depending on how the particular PC being used has been set up. To navigate to the location containing the settings file to be uploaded, click on the Browse button ![folder icon](image) (the folder symbol to the right of the **File Name** field), which will open a further **Open** dialogue box. Navigation may be continued in the normal Windows manner. Note that Intellivox settings files always have an `.ini` file extension.

• Select the correct settings file and click **Open**. Then in the **Load control parameters settings** dialogue box, click **OK** to continue. An **Info** dialogue box will then open showing additional information; click **OK** in this box to start the upload process. This will transfer the pre-determined Intellivox parameters to the loudspeaker. The **Control parameters** dialogue box can now be closed and the upload is complete.

• If there are further loudspeakers on the network to have their settings files uploaded at this time, the procedure can be repeated by selecting the next Intellivox. It is possible to load the same settings file into several Intellivoxes simultaneously, should the installation require this. See **Addresses and Groups** in the WinControl Help file for more information.

* See WinControl Help files for information regarding further Load options.
5. APPENDIX

OPTIONAL ACCESSORIES

Listed below are a number of additional components which may be required for an individual installation.

Other installation-related accessories:

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ORDER CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intellivox HP-series XLR Input plate</td>
<td>802145</td>
</tr>
<tr>
<td>Intellivox HP-series Cable gland plate with two M25 holes</td>
<td>802140</td>
</tr>
</tbody>
</table>

Network Accessories

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ORDER CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial interface converter, USB to RS-485</td>
<td>387802</td>
</tr>
<tr>
<td>Adapter cable XLR 5p Female&gt; Phoenix 5p, length 5 m</td>
<td>97660090</td>
</tr>
<tr>
<td>Adapter cable XLR 5p Female&gt; Phoenix 5p, length 0.5 m</td>
<td>97660099</td>
</tr>
</tbody>
</table>
Drill template for Intellivox HP-DS/DC
For more information see install manual and mechanical details

Print on A4, No scaling!

Reference point for acoustical mounting height in case of lower bracket.

Drill Hole 10 mm

Verify all dimensions after printing.

Distance to centre upper bracket in case of HP-DS/DC70: 1142 mm
Distance to centre upper bracket in case of HP-DS/DC370: 3182 mm
Distance to centre lower bracket in case of HP-DS/DC70: 1142 mm
Distance to centre lower bracket in case of HP-DS/DC370: 3182 mm

150mm [5.906 Inch]

178mm [7.008 Inch]

12 mm [0.472 Inch]

Fig. 20 Drilling Template.
COMMON ANALOGUE GROUNDING ISSUES

Correctly connecting the Intellivox to ground has several benefits:

1. **Safety** – the Protective Earth terminal of the AC mains connector provides a direct low impedance path from the metal parts of the chassis to ground. Always connect this terminal.

2. **Reduction of RF emission** – although the Intellivox electronics are well shielded and external connections are decoupled to prevent RF emission from the internal high speed digital circuits, this protection will not work properly if the chassis is not connected to ground.

3. **RF Immunity** – RF currents induced in the signal cables by external RF fields are effectively shorted to chassis-ground, provided that the cable screen (shield) is of sufficiently low impedance.

In addition to the mains ground, the Intellivox connectors have ground pins marked in two different ways. Each serves a dedicated purpose and care should be taken that they are not interchanged or connected to each other.

- Pins marked **GND** are connected internally directly to the chassis of the Intellivox. There are GND pins on the audio line input connectors. These GND pins are for connecting the screen (shield) of the audio cables.

- The RS-485 connector has one pin marked **DGND** and is intended as a terminal for the network cable screen (shield). Since the RS-485 interface is optically isolated (to prevent ground loops), DGND has no relation to the chassis ground. DGND should not be connected to any other ground pin (GND) on the chassis.

SOFTWARE AND FIRMWARE UPDATES

The JBL WinControl application is freely available and can be downloaded from the download area of our website; [www.jblpro.com](http://www.jblpro.com). We advise installers, users and engineers to check our site regularly for updates. Intellivox firmware and DSP software upgrades will also be made available through the website.

For further information about how to use WinControl please refer to the WinControl Help files.

NETWORK CABLES

The type of cable necessary for correct operation of the RS-485 network is twin twisted pair with each pair individually shielded. Numerous cables of this type are readily available and cables broadly meeting the specifications of the example cable given below are likely to be suitable.

Example of a preferred cable type:

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Belden 'Datalene' series</td>
</tr>
<tr>
<td></td>
<td>No. 9729 2-pair</td>
</tr>
<tr>
<td>Characteristic impedance</td>
<td>100 Ohms</td>
</tr>
<tr>
<td>Capacitance (core to core)</td>
<td>41 pF/m</td>
</tr>
<tr>
<td>Capacitance (core to screen)</td>
<td>72.5 pF/m</td>
</tr>
<tr>
<td>DC resistance (core)</td>
<td>78.7 Ohms/km</td>
</tr>
<tr>
<td>DC resistance (screen)</td>
<td>59.1 Ohms/km</td>
</tr>
</tbody>
</table>